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GETTING STARTED

Getting Started

Introduction

Synchrony s analytic software designed for business analysts and decision-makers
to examine in-depth relationships across multiple aspects of their businesses. Based
on the foundation of relational OLAP, and extended to encompass the full

capability of multidimensional analysis, Synchrony permits you to understand your
true business drivers. By utilizing temporal concepts and methodology, Synchrony
becomes the framework for a new clasaralytic application

The goal of this documentation is to familiarize you with the ways you can use
Synchrony to answer your important business questions so that you can begin using
it productively right away. Utilizing sample databases, you will take control of
business scenarios for a grocery store, credit card transactions, and a frequent flyer
program. By doing so, you will learn how to maximize the power of Synchrony

from your own desktop, and be able to apply what you learn in these scenarios to
answer your own business questions.

About Synchrony Demo

There are three data marts available on Synchrony Demo. Each of these data marts
has five reports associated with it. You may open any of these reports and run them
against the databases provided with the software. Chapters 2, 3, and 4 in this
document describe in a step by step manner how each of these reports were
constructed. We suggest that you choose the data mart that most interests you and
step through the construction of at least a few of the reports included. You may also
want to try constructing reports of your own design.

The data marts included with Synchrony Demo are:




GETTING STARTED

Credit Card Transactions Data Mart

This is a marketing/customer profitability sample database from the credit card
industry that includes credit cardholder account number, address, demographic, and
purchase transaction information. Data is available for Q4 1994 and Q4 1995.

Grocery Data Mart

This is a sample database from the retail industry that includes product, sales,
promotion, and store information. Data is available for the full years 1994 and
1995.

Frequent Flyer Data Mart

This is a revenue generation/loyalty program sample database from the airline
industry that includes customer, flight, fare, and sales channel information. Data is
available for Q4 1994 and Q4 1995.

Synchrony Demo allows you to run reports scripted in this document and any
reports you construct on your own. All reports constructed must use one of the
sample data marts included. Synchrony Demo does not support the ability to query
your own data marts. To try your own data, please cahtadb find out about the
Synchrony Evaluation Program.

Synchrony Demo runs with Microsoft Access databases that are included with the
Synchrony Demo CD. The full version of Synchrony supports a number of
RDBMSs as listed in the Synchrony Data Sheet.

Synchrony Demo supports “one-button” access to Microsoft Excel from the
Synchrony application. Unlike the full version of Synchrony, Synchrony Demo
does not support the ability to call Synchrony directly from Excel.

The titles for the Synchrony Demo reports include the names of the sample data
marts. For exampl€redit Card Transactions — Simple Querymeans that the
Credit Card Transactions data mart is uséols must seledCredit Transactions
when creating a new repobee the sectio@reating Your First Report.
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To Install Synchrony Demo

* Please insert the Synchrony Demo CD and follow the installation instructions
on screen. If the CD does not autorun, gadd/Remove Programsin the
Control Panel, and click thenstall button. Follow the instructions on your
screen.

* Note that in addition to installing the Synchrony Demo software, the Synchrony
User Manual will also be installed in both HTML and Microsoft Word 7.0
formats. You may refer to those documents to supplement the information
contained within this document.
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Getting Started

* By default, the installation program has already configured Synchrony Demo to
run the sample data that we are going to be using in order to familiarize you
with the product.

* Upon launching the program, you are presented with two chdleesReport
andOpen Report These options are also available fromRife menu.

Synchrony™

HEW REPORT OFEN REPORT

» To create a new report, click dlew Reportand select the data mart for which
you wish to create a report.

» To open an existing report, click @pen Report, expand the report list for one
of the provided data marts, and choose one the existing reports.

* The main Synchrony window will appear. The main Synchrony window is
divided into two parts; thReport Pane which takes up the lower half of the
screen and resembles a spreadsheet, ar@thiéy Pang which takes up the
upper half of the screen.




GETTING STARTED

fle i Yewes Hepoi Jook el

A [ [ T s ™
T ol Tirwss Toakes Facis [ &l | Poodar 2 Fwakack;
Fook | lioups | oot | T Fiokts | Booupe | Stk |
[imia S - EEE fuandd i'
[ e P bt s B ik Wl pPanhase Dods g ot 1 P It
i i Bkt [ B Pariae Kunks B Coisgony
2% [y 07 s ";'_:':"' ot Conrd i Depwwe
% Feseal Fermad & Dol Cant i Dprraon
ﬂ | .;."l".liu':-i-.: ﬂ
Frarckon &3 Prarskan W S g Yem Al Slns
Fiakch | Gicsips | Gonias | “;:1 i Finiskc | s | S|
- s &l
& e | 5 e 8
2% il Tpom =5 g EE — & Froes Yo T
Lt | ypa = | FEY Frst Lpsred U i
Dieplag Preracds i & b :l P Man Tppa
Dliphsn Tros =l Fugen Sk &
= Family Pane =
i Corniam
SR S i S ] S S F S S N RS S Sl S il SIS Sl [ T
=a Report Pane
| i B
B
LB
| 5N
TIL | rl_}

Faardy | Gancary ETeTT, Im

The central table shown in the Family pane is calledicetable The tables
arranged around the Fact table are referred@onasnsion tables In every

Family Pane, there is always a Fact table, and anywhere from 1 to 20 Dimension
tables. In the illustration above, the Family pane is display8tairiView mode.

If there are too many dimensions to effectively display the information in Star View
mode, Synchrony will automatically switch$mgle Viewmode. In Single View
mode, you will see a list that includes the titles of the available dimension tables.
By clicking on the dimension table you wish to view, you will see the details of
your chosen dimension table displayed.

The Fact table contains the factsp@asures relating to your business. Anything
from the Fact table can be dragged down onto the report pane. To do so, point at
the item in the Fact table you wish to drag onto the report pane, hold down the left
mouse button, and drag the icon onto the report pane.

A dimension table contains listsfeelds, Groups, andStudies Fields represent

the attributes associated with the dimension. Groups and Studies represent
constraints constructed for a dimension. You can select between these three by
clicking on the Fields, Groups, or Studies tab on a given dimension.
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The three have somewhat different characteristics in the way in which they are
applied to a report in Synchrony.

First, only Fields can actually be dragged from the given dimension table directly
onto the report pane, as can anything from the Fact table. To do so, point at the
item in the Dimension table you wish to drag onto the report pane, hold down the
left mouse button, and drag the icon onto the report pane.

Groups and Studies, on the other hand, are constraints that may be applied either to
the report as a whole, or to individual fact columns in the report. To apply a Group
or Study constraint, simply drag and drop it onto a fact column or onto the report
title area. In other words, Groups and Studies cannot be used to create columns in
the report pane, only to constrain existing fact columns there.
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Toolbar and Menus
Before we delve deeply into Synchrony, let's go over some basic toolbar and menu
functionality,

NTW Save Star Report Stop Browse

Ozl ¢ meEal olele] o 2

Open Print Single Run Refresh Help

MHew... Ctrl+k

Open... Chrl+0

Cose

Save Chl+5 Single Bun Help

Save As.. r

aveos Star Loy Erowze Syrchrony Help

Beport Fefresh :

elete. = | Coov B Booksz Online
- Stap Lopy Repart...

Print... Chrl+P ~ __ BunBatch.. if... on the 'wWeb »

= Tirning F12  [Duill Across F5 b SUTE ST

Exit Chrl+ Agaregate Diill Analysi: F4  Options ¥ | Aboutif.. Synchrony

* The purpose of th€lear function on the Report menu is to clear the results
obtained from running the report. The column headers remain intact.

* On theHelp menu, Synchrony Help brings up the standard help dialog
including an index, as does the question mark icon on the toolbar. Books
Online brings up the Synchrony User Guide, wifileon the Web consists of
relevant links to thé... website.

* Single Star andReport on the View menu and on the toolbar change how the
main window is displayed.

* SelectingRun from the Report menu runs the report. Seled®efyeshre-
executes all of the queries which are associated with the report.

» Stopinterrupts the running of a report.
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Creating Your First Report
To create a new report:
1. Click on theCreate New Reportgl button or click on New Report from the

splash screen if you have just launched the program. Alternately, select
File>New...

2. This will pop up theNew Reportdialog.

3. From this dialog, scroll down and choose one of the three available data marts,
then clickOK.

Chapters 2, 3, and 4 in this document walk you through the process of constructing
a new report. You should select one of the available data marts and try following
the steps described in constructing a report as detailed in one of those chapters.
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CREDIT CARD DATA MART

Credit Card Data Mart

Lily is in the Credit Risk Department of a major credit card company. She wants to
understand how much credit risk each state had outstanding during November
1995. November is traditionally a high spending month because of the holiday
season.

This is a simple query that shows a snapshot of data in time. Most query tools can
run simple queries such as this one.

To create a new report

Go toFile=>»New on the menu.

Click onCredit Transactions.

Click OK.

If a dialogue box comes up asking if you want to save the reporiNdick
Click View->»Singleon the menu.

1. To select fields for your report:

* From the Day dimension, drag and di2gte onto the report pane.

* From the Account dimension, drag and démgount Stateonto the report
pane.

* From Card Transactions (Fact table), drag and @ropent Debt onto the
report pane.

* From the Day dimension, click tli&oups tab and drag and drddonth =
Nov 19950nto the report title area.

2. To create report title:
* Right click on the report title area.
* Click in the Report Title edit box and ty@eedit Card Transactions —
Simple Query:.
* Click Close

3. To create a subtotal:
* Right click on column A (Date) and seld@toperties>Break by.
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QUERY

CREDIT CARD DATA MART

¢ Check theBreak on this columnbox to enable it.

* Click OK.

4. To run the report:

* Click Run Report _|

5. To view full report:

* ChooseView->Report from the menu.

if. Synchrony - [Single Yiew]

Fil= Edit “iew HBepot Toolz Help

_I_I_I_I!I!ILIiI;I_I_I_I

e, — Dimenzions [Day: Month = Moy 1995]
B fzcount Key Dy Figlds I Groups | Studiesl
&Amount Account @

) _ = | |Card Product Date -
@Avallable Credit Househald &= Day Key j
&= Card Product Key Statuz @ Dap Humber In Manth
& Currert Debt ;I Transaclion @ D ay Mumber Overall

& Day Of week =]
| Credit Card Transactions - Simple Querny
| far Maonth = Mow 1995
A [ B C [ o T e [ F [«
Sum of —
1 |Break By Account Current
D ate State Debt
11 11/01/1995 Morth Carolina $1.567.11
12 11,/01/41995 South Caralina $3.369.64
13 11,/01/1995 South Dakata $3.508.97
14 11/01/1395 Vermont $3555.20
15 | Tatal 114011995 $40,286.59
16 11,/02/1995 Alabama $3.273.91
17 11/02/1995 Hawai $1 759.09 -
| Family: | Credit Transactions | mrame | 1nddeM

This is an example of a simple query that shows a snapshot of data in time. Most
query tools can run simple queries such as this one.

Evan is in the Marketing Department of a major credit card company. He believes
that customers holding high interest credit cards are high-risk spenders. Evan
wants to look at the spending patterns and the debt load of his high interest card
customers over the heavy purchasing period of November and December 1995 and
compare the differences in purchasing behavior and average current debt for each

customer.

10
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This is a complex query whereanstraint is created to look at only customers in

the High Interest Card Product Category and only in the months of November and
December 1995. Thercamparisonis made between the two months and a
percentage difference is calculated. Synchrony is able toatbavicdataand

identify individual customer account information within the High Interest Card
Product constraint. Some query tools are able to run queries with constraints and
comparisons. However, few are able to reatamnic data(e.g. individual

customer accounts, names, addresses) with constraints and comparisons applied.

To create a new report

Go toFile->New on the menu.

Click onCredit Transactions.

Click OK.

If a dialogue box comes up asking if you want to save the reporiNmick
ChooseView->Singleon the menu.

1. To create report:

From the Account dimension, drag and démaount Noonto column A.
From Card Transactions (Fact table), drag and Avadable Credit onto
column B.

From Card Transactions, drag and dxymber of Transactionsthree
times onto columns C, D and E.

From Card Transactions, drag and d@yprent Debt threetimes onto
columns F, G and H.

2. To constrain report and create report title:

In the Card Product dimension clitte Groups tab and drag and drop
High Risk onto the report title area.

Right click on the report title area.

Click in the Report Title edit box and ty@edit Card Transactions —
Complex Query.

Click Close

3. To calculate an average of available credit:

Right click on column B (Available Credit) and select
Properties>Aggregate

SelectAverage

Click OK.

4. To select dates to constrain report columns:

From the Day dimension, click tié&roups tab and drag and drop the
following:

a. Month = Nov 1995to column C (Number of Transactions)

b. Month = Dec 19950 column D (Number of Transactions)

11
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Month = Nov 1995to column E (Number of Transactions)
Month = Nov 1995to column F (Current Debt)
Month = Dec 1995to column G (Current Debt)
Month = Nov 1995to column H (Current Debt)

~® Qo0

5. To create comparisons:

Right click on column E (Number of Transactions Nov 1995) and select
Properties>Comparison.

SelectPercent Difference of

Click OK.

Right click on column H (Current Debt Nov 1995) and select
Properties>Comparison.

SelectPercent Difference of

Click OK.

While holding down th&hift key, drag and dropMonth = Dec 1995from
theGroups tab on the Day dimension onto column E (Percent Difference
of Number of Transactions). Using the shift key sets the date as the one
being compared.

While holding down th&hift key, drag and dropMonth = Dec 1995from

the Day dimensiofsroups tab to column H (Percent Difference of Current
Debt) Using the shift key sets the date as the one being compared.

6. To create averages:

Right click on column F (Current Debt Nov 1995) and select
Properties>Aggregate

SelectAverage

Click OK.

Right click on column G (Current Debt Dec 1995) and select
Properties>Aggregate

SelectAverage

Click OK.

Right click on column H (Current Debt Nov 1995) and select
Properties>Aggregate

SelectAverage

Click OK.

7. To remove blank rows:

Right click on column C and seldétoperties>Exceptions
Check theOmit Nulls box.
Click OK.

To run the report:

Click Run Report _I

12
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9. To switch to report view:
* ChooseView>Report from the menu.

if. Synchrony - [Single Yiew]

Eil= Edit “iew Bepot Toolz Help

clzlel ¢ mEE| =B8] 2 2 |

e a— | — Dimenzions [Day: All Dayz]
E= Account Key [ray Fields | Groups I Studiesl
Accaunt
@Amqunt ) —' | Card Product @ Date -
&-‘5-""3”5'3'3 Credit Huougehold E=Day Key
&= Card Product Key Stafus &% Diay Mumber In Month
& Current Debt LI Transaction @ Dray Number Overall
PR & Dy Of Week H
| Credit Card Transactions - Comples Query
| for High Fisk
A B | C | D [ E I T & | H =
Percent Percent
Difference of Difference of
Sum of Avg of
Mumber of Current
1 Sum of Sum of Transactions Avg of Awvg of Debt
Number of Number of for Month = | Cumrent Current for Month =
Avqg of Transactions Tranzactions Dec 1995 Debt Debt Dec 1995
Account |Available |for Month = for Month =  vs. Month =  for Month = for Month = | vs. Month =
No Credit Nov 1995 Dec 1995 Moy 1995 Nov 1995 Dec 1995 Moy 1995
2 1230010023 $1.687.77 15 32 113.33% $3.563.04 $3.214.45 53
3 1230010054  $1.25225 24 43 PR NES $2.282.33 $1.518.91 3345%
4 1230010055  $2.393.08 k] 4 24 24% $1.525.46 $1.861.53 2203%
5 [1230010083]  $1.038.52 13 21 51.54% $2.664.71 $2.402.52 982k
g 1230010071  $1.92667 c:] 45 15.38% $2.876.63 $1.971.12 31.48%
7 [1230010095|  $2.548.87 20 32 B0.00% $1.173.84 $1.810.11 342%
J | il
[ Family: | Credit Tranzactions [ erame | 11EDAM g

This is a complex query whereanstraint is created and@mparisonis made
between two periods of time. Some query tools are able to run queries with
constraints and comparisons. However, few are able to e¢poric datae.g.

individual customer accounts, names, addresses) with constraints and comparisons
applied.

Paige is in the Marketing Department of a major credit card company. She wants
to increase interest revenue for the company by increasing the average current debt
of customers. She knows that household income is a business driver of purchasing
behavior. She wants to look at the change in average current debt and total
number of transactions for the months of November and December 1994 for
customers that were granted a credit limit increase of $1000 or more in November
1994. She wants to list the report by household income, account number, sum of
total transactions, average available credit, average current debt for October and
November 1994, percentage difference between the two months, sum of

13
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transactions for October and November 1994, and percentage difference between
the two months.

This is a very complex query wher&tudy is created tgave the results of a
constraintof customers that were granted credit limit increases of $1000 or more in
November 1994. Synchrony has the unigue ability to create Stlilesesults of
applying constraints on various dimensions in a report can be saved as a

Study.

Slowly changing dimensiongontain data that tend to change gradually over

time. Customer and product information are the most common data that varies
over time. If the speed of your industry is outpacing your data, then chances are
you have data that varies over time and you need analytic software that can track
slowly changing dimensiondn this exampleslowly changing dimensiorse
demonstrated by identifying tishangan average current debt and total number of
transactions between the periods October and November 1994. Do you have
analytic software that can tell you what changed over time?

To create a new report

Go toFile=>»New on the menu.

Click onCredit Transactions.

Click OK.

If a dialogue box comes up asking if you want to save the reporiNdick
ChooseView->Singleon the menu.

1. To select fields for your report:

* From the Household dimension, drag and diopsehold Incomeonto
column A.
From the Account dimension, drag and déggount Noonto column B.
From Card Transactions (Fact table), drag and Armpunt onto column
C.
From Card Transactions, drag and déepilable Credit onto column D.
From Card Transactions, drag and d@yprent Debt threetimes onto
columns E, F and G.
From Card Transactions, drag and dxymber of Transactionsthree
times onto columns H, | and J.

2. To create report title:
* Right click on the report title area.
* Click in the Report Title edit box and ty@eedit Card Transactions —
Query with SCD.
* Click Close

3. To create a Study:

14
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* This study has been created for you. If you wish to create it yourself, follow
these steps. Otherwise, skip to step 4.

With the Account dimension selected, click Bmwseﬁ button.
SelecfTools>Study Changesrom the menu

Select theCredit Limit field to study

For Type, choos¥alue Increase

In the box marked Mienter 1000

SelectMonth = Nov 1994for the time constraint for the study.
Click OK.

Namethe studyCredit Limit Increase $1k+ in 11/94

Click OK.

Close the Browser window.

SQ@rpapop

— —

4. To use the Study:
* From the Account dimension, click tBéudiestab and drag and drop the
study namedredit Limit Increase $1k+ in 11/94to the report title.
*  When prompted to choose a time period for the study, gdlefttime and
click OK.

5. To select dates to constrain report columns:
* From the Day dimension, click tli&roups tab and drag down the
following:
Month = Nov 1994to column C (Amount)
Month = Oct 1994to column E (Current Debt)
Month = Nov 1994to column F (Current Debt)
Month = Oct 1994to column G (Current Debt)
Month = Oct 1994to column H (Number of Transactions)
Month = Nov 1994to column | (Number of Transactions)
Month = Oct 1994to column J (Number of Transactions)

@*pap o

6. To create an average:
* Right click on column D (Available Credit) and select

Properties>Aggregate

* SelectAverage

* Click OK.

* Right click on column E (Current Debt Oct 1994) and select
Properties>Aggregate

* SelectAverage

* Click OK.

* Right click on column F (Current Debt Nov 1994) and select
Properties>Aggregate

* SelectAverage

* Click OK.

15
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Right click on column G (Current Debt Oct 1994) and select
Properties>Aggregate

SelectAverage

Click OK.

7. To create comparisons:

Right click on column G (Current Debt) and select
Properties>Comparison.

SelectPercent Difference of

Click OK.

Right click on column J (Number of Transactions Oct 1994) and select
Properties>Comparison.

SelectPercent Difference of

Click OK.

While holding down th&hift key, drag and droponth = Nov 1994from
theGroups tab on the Day dimension onto column G (Percent Difference
of Current Debt). Using the shift key sets the date as the one being
compared.

While holding down thé&hift key, drag and droponth = Nov 1994from
theGroups tab on the Day dimension onto column J (Percent Difference of
Number of Transactions). Using the shift key sets the date as the one being
compared.

8. To create an exception:

Right click on column C (Amount) and sel&bperties>Exceptions
For Top Condition click ot or Above Value of M

Enter500in theM = edit box.

For Report Display, clicRestrict to Exceptions

Click OK.

9. To run the report:

Click Run Report _I

10. To view full report:

ChooseView = Report from the menu.

16
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if. Synchrony - [Single View]
File Edit “iew Heport Toolz Help

Ol ¢ BEE| =s] 2] 2 |
| -

Cord Trarsachions ~ Dimension: [Daw &l Days]

&= Account Key Day Fields I Groups | Studies|

&Amc!unl ' — égrcdog?;duct S Date o
&Avallable Credit Hougehold &= Day Key

&= Card Product Key Status & Day Mumber In Manth

& Cunent Debt =l Transaction &% Day Number Overal

S S Day O wesk =

| Credit Card Transactions - Query with SCD
| for &l Accounts with Credit Limit Increase $1k+ in 11/94

4 | B t [ o ] E | F | G [ H =
Percent r
Difference of
Avg of
Current
1 Avg of Avg of Debt Sum of
Sum of Current Current for Month = Mumber of
Amount Avg of Debt Debt Moy 1994 Tranzactions
Houzehold Account |for Month =  Available for Month =  for Month = vz, Month = for Month =
Income Mo Nov 1994 Credit Oct 1994 Nov 1994 Oct 19934 Oct 1994
2 $24,337 1230010052 $4.4658.78 201509 $994.71 $2.476.91 149.01% 44
3 $27.014 1230010012 3342918 $312215 $79312 $1.257.89 BE.60% 35
4 $41.004 1230010022 3638200 $240322 $1.070.44 $2.577.94 140.83% 44
5 $41.267 1230010032 291894 $2E74.39 $552.95 $1.804.1 226 3% 23
B $102.996 1230010002 3316069 $2E57.43 $934.47 $1.448.89 BE.05% 39
7 $115,967 1230010032 $373.83 $3.24058 $519.36 $654.52 2012% |,
| | LI_‘
| Family: | Credit Transactions | esams | 1221PM

This is an example of a very complex query whestudy is created anslowly
changing dimensionsare demonstrated by identifying ttieangebetween two
periods of time. Synchrony is the only analytic software today that combines the
power ofStudiesandtemporal technologyto trackslowly changing dimensions.

Ellie is in the Finance Department of a major credit card company. She is looking
for ways to increase revenue for her company. She wants to look at the revenue of
the customer segment that is expected to have the highest revenue growth rate in
her company. The customer segment criteria has household income over $50,000,
no overdrawn status, average debt of $500 or more in 1994, and a family
household type. She will calculate interest revenue by multiplying average current
debt by 12% which is the interest rate that her company charges. She wants to list
the report by household income, account number, average current debt, and annual
revenue (average current debt multiplied by 12%).

This is a complex query wheresgudy is created tgave theesults of a constraint
of the customer segment. Synchrony has the unique ability to create.Sthdies

17



CREDIT CARD DATA MART

results of applying constraints on various dimensions in a report can be saved
as a Study

A calculation is done from the results of the Study to determine interest revenue
from average current debt.

Few query tools are able to savensults of constraintas in Synchrony. Some
guery tools can creatdilier which is a set of constraints, but cannot savedtt
setfrom the constraints. Thus, Synchrony savesasits of constrainta/hich
can then be used as the basis of other reports.

To create a new report
* Go toFile->New on the menu.
* Click onCredit Transactions.
* Click OK.
* |f a dialogue box comes up asking if you want to save the reporiNdick
* ChooseView->Singleon the menu.

1. To create a Study
* This Study has been created for you. If you wish to create it yourself,

follow these steps. Otherwise, skip to step 2.

From the Household dimension, click mmwseﬁ button.

In the Browser window, drag and drpusehold Income

Click inside the Household Income edit box agpe >50000

Drag and droplousehold Typeand clickFamily.

Click Run.

Click Saveto save this constraint as a Group.

Namethe Grougncome > $50k and Type = Family

Click OK.

Close the Browser window.

From the Account dimension, drag and démeount Key.

From Card Transactions (Fact table), drag and Gropent Debt.

From the Day dimension, clicBroups tab and drag and drogear =

1994to the report title.

m. From the Household dimension, cliGkoups tab and drag and drop
Income > $50k and Type = Familyto the report title.

n. From the Status dimension, cliGoups tab and drag and drdptatus
= Not Overdrawn to the report title.

0. Right click on column B (Current Debt) and select

Properties>Exceptions

For Top Condition, seleétt or Above Value of M

Enter500in theM = edit box.

For Report Display, chedRestrict to Exceptions

SQ@rpapop

—_ 7\—‘— -

a7
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Click OK.

Click Run Report.

Right click on column A (Account Key) and seléliteate Study.
Namethe studyFamilies > $50k income, >$500 debt in 1994, not
overdrawn.

Click OK.

w. To clear the report used in creating the Study, chiedese New from
the menu and select tlizedit Transactions family and clickOK.
When asked if you want to save the report, respand

ccvow

<

2. To create report title:

Right click on the report title area.

Click in the Report Title edit box and ty@zedit Card Transactions —
Query with Study.

Click Close

3. To select fields for your report:

From the Household dimension, drag and dtopsehold Incometo
column A.

From the Account dimension, drag and démaount Noto column B.
From Card Transactions (Fact Table), drag and Gropent Debt to
column C.

4. To select a Study for report:

From the Account dimension, click tB¢udies taband drag and drop the
studyFamilies > $50k income, >$500 debt in 1994, not overdravamto
the report title.

5. To create an average:

Right click on column C (Current Debt) and select
Properties>Aggregate

SelectAverage

Click OK.

6. To create a user defined formula for interest revenue:

From Card Transactions, drag and dusier Defined Formulato column
D.

Click in the edit box for the Calculation and er@@&0.12 - This means
column C times 12%.

Click OK.

7. To create column heading:

Right click on column D and seleBtoperties>»Headings
Select all the text in theolumn Headingedit box and press tiizelete key
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* Enter a new heading gknnual Revenue <Enter> at 12% Ratepressing
the Enter key where you see <Enter>.
* Click OK.

8. To run report:
* Click Run Report _I

9. To view full report:
* ChooseView->Report from the menu.

if. Synchrony - [Single View]
File Edit “iew Heport Toolz Help
UO|2|E] €| BEa] o] e 2] 2 ‘
T e, | = | 1 Dimensions [Day: All Days]
&= Account Key Day Fields I Groups | Studiesl
Account
&Amc!unl i —! || Card Product &% Date 2
&Avallable Credit Houzehald &= Day Kay
&= Card Product Key ?::It'lisaction @ D ay Murmber [n Maonth
& Current Debt LI @ Day Murmber Oweral
b Day Of week -l
| Credit Card Transactions - Query with Study
| for All Accounts in Families > $50k income, > $500 debt in 1934, not averdrawn
P - c | D I e T ¢ | & | #Hw ] =
Avg of
1 |Household Account Cumrent  Annual Revenue o
Income Mo Debt at 12% Rate
2 $R80170 1230010081 $1.508.71 $181.06
3 $50639 1230010057 $1.086.32 $130.36
4 $51.543  1230010003) $1.279139 $153.50
] $52,291  1230010083| $1.531.6E $183.80
E $54,269 1230010078 $1.085.21 $130.22
7 $55679 1230010077 $1.364.31 $163.72
g $57.296 1230010085 $1.275.53 $153.07
| $59.791 1230010029) $1.428.93 $171.47
10 470,328 1230010041 $957.20 $114.86
11 470,810 1230010085 $1.017.33 $122.08
12 $71.,099 1230010025) $1.032.43 $123.89 =
pEs— = e Ll_‘
| Family: | Credit Transactions | a3 | 123PM

This is an example of a complex query whestaly is created and@alculation

is done on the results of the Study. Few query tools are able to save the results of
constraints as in Synchrony. Synchrony savessthéts of constrainta/hich can

then be used as the basis of other reports.
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Ellie is in the Finance Department of a major credit card company. She wants to
look for new ways to increase revenue for her company. Based on the customer
segment created in the previous query (household income over $50,000, no
overdrawn status, average debt of $500 or more in 1994, and a family household
type), Ellie wants to identify the subset of customers that carry an average current
debt greater than $1000. She wants to list the household income, account number,
account status, average current debt, and total number of transactions in 1994.

This is a complex query that useStady created in the previous example that

saved the results of constrainis the customer segmeihe results of applying
constraints on various dimensions in a report can be saved as a Stu8ynce

the Study was saved itnsusableand can be the basis of another query. This query
takes the results of the previous constraint and appliescaption The exception

restricts the constraint to those customers that have average current debt greater than
$1000.

To create a new report

* Go toFile=>New on the menu.

* Click onCredit Transactions.
Click OK.
If a dialogue box comes up asking if you want to save the reporiNdick
ChooseView->Singleon the menu.
This report uses the same Study as the previous report. See that report to
see how the Study was created.

1. To select fields for your report:

* From the Household dimension, drag and difopsehold Incomeonto
column A.

* From the Account dimension, drag and démgount Noonto column B.

* From the Status dimension, drag and @tgius Descriptiononto column
C.

* From Card Transactions (Fact Table), drag and Gropent Debt onto
column D.

2. To create report title:
* Right click on the report title area.
* Click in the Report Title edit box and ty@zedit Card Transactions —
Complex Query with Study.
* Click Close

3. To use a Study created in previous report:
* From the Account dimension, cli€tudies taband drag and drop the study
Families > $50k income, >$500 debt in 1994, not overdravim the
report title
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4. To create an average:
* Right click on column D (Current Debt) and select

Properties>Aggregate
* SelectAverage
* Click OK.

5. To select fields for your report:
* From Card Transactions, drag and dxapnber of Transactionsonto
column E.

6. To select a date to constrain a field:
* From the Day dimension, clicBroups tab and drag and dropgear = 1994
to column E (Number of Transactions).

7. To create an exception:

* Right click on top of column D (Current Debt) and select
Properties>Exceptions
For Top Condition click ot or Above Value of M
Enter1000in theM = edit box.
For Report Display, seleBtestrict to Exceptions
Click OK.

8. Torun report:
* Click Run Report _I

9. To select report view:
* ChooseView->Report from the menu.
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if. Synchrony - [Single View]
File Edit “iew Heport Toolz Help

Ol ¢ BEE| =s] 2] 2 |
| -

Cord Trarsachions ~ Dimension: [Daw &l Days]

&= Account Key Day Fields I Groups | Studies|

&Amc!unl ' — égrcdog?;duct S Date o
&Avallable Credit Hougehold &= Day Key

&= Card Product Key Status & Day Mumber In Manth

& Cunent Debt =l Transaction &% Day Number Overal

S S Day O wesk =

| Credit Card Transactions - Complex Query with Study
| for All Accounts in Families > $50k income, > $500 debt in 1934, not averdrawn

s | B | C o | E | F | & | H =
Sum of
1 Avq of Humber l:_nf o
Household Account Cumrent | Transzactions
Income Mo Status Description |Debt for Year = 1994
2 $50170 1230010081 Marmal $1.508.71 90
3 $50639 1230010057 Mormal $1.086.32 7E
4 $51.543 1230010003 Marmal $1.273.19 94
] $52.291 1230010063 Marmal $1.531.66 a5
E 454,269 1230010073 Mormal $1.085.21 45
7 $8RE7S 1230010077 Marmal $1.364.31 103
g $57.296 1230010085 Moarmal $1.275.59 114
| $53,791 1230010023 Mormal $1.428.93 1
10 470,810 1230010065 Marmal $1.017.33 45
11 $71.099 1230010025 Marmal $1.032.43 a3
a2 471207 A O00E M e +1 77 EF 105 x
<i | =
| Family: | Credit Transactions | esarae | 10SPM

This is a complex query wheré&éudy was created in the previous example and

used as the basis of this complex query.eReeptionis applied to the Study that

restricts the constraint to those customers that have average current debt greater than
$1000. Few query tools are able to savedhelts of constraintas in Synchrony.
Synchrony saves thiesults of constrainteshich can then be used as the basis of

other reports.
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SIMPLE

QUERY

GROCERY DATA MART

Grocery Data Mart

Caleb is in the Accounting Department of a major grocery store chain. He wants to
compatre the total dollar sales for each product for the month of November 1995
compared with November 1994 and see the percentage change between the two

This is a simple query that compares two snapshots of data in time. Most query
tools can run simple queries such as this one.

To create a new report:
* Go toFile=>New on the menu.
* Click onGrocery.
* Click OK.
* If a dialogue box comes up asking if you want to save the reportNdick
* ChooseView->Singleon the menu.
ETO select fields for your report:
* From the Product dimension, drag and ddegscription onto column A.
* From Sales (Fact Table), drag and dbgflar Salesthreetimes onto
columns B, C and D.

2. To create report title:
* Right click on the report title area.
* Click in the Report Title edit box and tySémple Query.
* Click Close

3. To select dates to constrain fields:
* From the Time dimension, click ti&oups tab and drag and drop the
following:
a. Month = 11/30/1994to column B.
b. Month =11/30/19950 column C.
c. Month = 11/30/1994to column D.

4. To create a comparison:
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GROCERY DATA MART

* Right click on column D (Dollar Sales 11/1994) and select

Properties>Comparison.
* SelectPercent Difference of.
* Click OK .

*  While holding down th&hift key, drag and droponth = 11/30/1995
from theGroups tab on the Time dimension onto column D. Using the
shift key sets the date as the one being compared

5. Torun report:
* Click Run Report _I

6. To view full report:
* ChooseView->Report from the menu.

if.. Synchrony - [Single View]
File Edit “iew Beport Toolz Help

sEEE e EEEREENE] |
| N

Sales — Dimensions [Time: Al Times]
é@tustomer Count ;imde Fields | Groups | Studiesl
roduct
{9 Dollar Cost Pramation & Date =
& Dollar Sales = | |store 8 Day Number In Manth
&= Product Key 8 Day Number Dveral
&= Promuotion F.ey LI @ Day Of week
S R Fiscal Period hd|
| Simple Quemn
| Mo Constraints
A B I C I D [ e T ¢ T & [ W [ =
Percent [
Difference of
Sum of
1 Dollar Sales
Sum of Sum of for Month =

Dollar Sales Dollar Sales | 11/30/1935
for Month = for Month = vs. Month =
Description 11/30/1994 1173041995 1173041934

2| Athletic Drink, $6.219.91 $6.844.45 10.04%

3 |Beef Stew $9.206.05 $9.091.77 A.24%

4 | Buffalo Jerky $10.705.40 $13.032.35 21.74%

5 | Chicken Dinner $10,585.24 $10,345.32 2.27%

E | Clear Refresher $5.171.80 $6.363.10 2.70%

7| Dried Giits $5.574.47 $6.301.01 23.80%

8 | Dy Tissues $5.,616.52 $5.281.74 -5.96% =
1] | LlJ

| Family: | Grocery | mvase | 12EPM 4

This is a simple query that compares two snapshots of data in time. Most query
tools can run simple queries such as this one.
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Evan is in the Sales Department of a major grocery store chain. He wants to
increase the number of promotions and amount of sales on products sold in his
company. The manufacturer of the National Bottle brand wants to do a store
promotion where samples of the National Bottle drinks are given out along with
coupons. In return, the manufacturer will pay the grocery store chain 1% of the
price of each bottle sold. Evan wants to estimate the incremental sales to his
company. He will make his estimates based on the sales from the last National
Bottle brand promotion and add 1% to calculate incremental sales. He wants to list
the description of the product, total sales during the promotion, and incremental
sales from the promotion

This is a complex query whereanstraint is created to look at only National

Bottle brand products during the period of the last promotion. Theera

calculation is made to multiply the total sales of the National Bottle brand

constraint by 101% to get to incremental sales. Some query tools can run this type
of query.

To create a new report:
* Go toFile=>New on the menu.
Click onGrocery.
Click OK.
If a dialogue box comes up asking if you want to save the reportNdick
ChooseView->Singleon the menu.

1. To select fields for your report:
* From the Product dimension, drag and dfafp Description onto column
A
* From the Sales (Fact Table), drag and d@oltar Salesonto column B.

2. To constrain report and create report title:

* From the Product dimension, click @eoups tab and drag and drop
Brand = National Bottle onto the report title area.
From the Promotion dimension, click @eoups tab and drag and drop
Promotion Name = Big Promato the report title area.
Right click on the report title area.
Click in the Report Title edit box and ty@®nstraint and User
Calculation.
Click Close

3. To create a user defined formula:
* From Sales, drag and drbjser Defined Formulaonto column C.
* Click in the edit box for the Calculation and erd&t.01 - This means
column B times 101%.
e Click OK.
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Right click on column C and seleetoperties>Heading.
Select all the text in theolumn Headingedit box and press tiizelete key

4. To create a column heading:
* Enter a new heading bicremental Sales
* Click OK .

5. To run your report:
* Click Run Report _I

6. To view full report:

if. Synchrony - [Single View]
File Edit \iew Heport Toolz

Help

ChooseView->Report from the menu.

Clzlgl ¢ BEw] v =lE] 2 3| |
Sl [ =] Dimensions [Time: &1 Timesz]
Custamer Count Time Fields | Groups | Studies
&
& Dallar Cast E:gs;-ctiton &b Date =
& Dollar Sales || 5tore & Day Mumber In Manth
&= Praduct Key @ Day Mumber Overal
% E'-romollaion Key LI @ Day Of week,

@ Fizcal Period

Constraint and User Calculation

| for Brand = Mational Bottle, Promotion Mame = Big Promo

A B [ C [ o [ e [ ¢ [ & [ =
1 o Sum of
Full Description Dollar Sales  Incremental Sales —
2 | Clear Refresher 135 0z $354.19 $357.73
3| Clear Refresher 6 oz $263.56 $271.25
4 | Clear Refresher 9 oz $49.61 $50.11
5 | Shong Cala12 oz $168.57 $170.26
E | Stong Cola 18 oz $531.68 $537.00
7
3
g
10
11
12
13 -
1] | LlJ
| Family: | Grocery | esaras | 4m3PM

This is a complex query whereanstraint is created andaser calculationis
made to the constraint. Some query tools can run this type of query.
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Ryan is in the Marketing Department of a major grocery store chain. Some grocery
stores were expanded in January 1995 increasing the square footage of the retalil
space. He wants to determine if the increase in square footage has caused an
increase in the sales of the Western Vegetable brand. He wants to identify the
stores that had an increase in square footage in January 1995 and compare the
average sales of the Western Vegetable brand by region and by store between 1994
and 1995 and determine the percentage difference.

This is a very complex query wher&tudy is created to save tinesults of a
constraintof the grocery stores that had an increase in square footage in January
1994. Synchrony has the unique ability to create Stutiesresults of applying
constraints on various dimensions in a report can be saved as a Study

Slowly changing dimensiongontain data that tend to change gradually over

time. Customer and product information are the most common data that varies
over time. If the speed of your industry is outpacing your data, then chances are
you have data that varies over time and you need analytic software that can track
slowly changing dimensiondn this examplslowly changing dimensionsare
demonstrated by identifying tithangen average sales of the Western Vegetable
brand between 1994 and 1995. Synchrony is the only analytic software today that
combines the power &tudiesandtemporal technologyto trackslowly changing
dimensions.

To create a new report:
* Go toFile=>New on the menu.
Click onGrocery.
Click OK.
If a dialogue box comes up asking if you want to save the reporiNmick
ChooseView->Singleon the menu.

1. To select fields for your report:
* From the Store dimension, drag and dx@meto column A.
* From the Store dimension, drag and déaesRegion to column B.
* From Sales (Fact Table), drag and dbgffiar Salesfour times to columns
C,D,EandF.

2. To create report title:
* Right click on the report title area.
* Click in the Report Title edit box and tyféowly Changing Dimension
* Click Close

3. To select dates to constrain fields:
* From the Time dimension, click tii&roups tab and drag down the
following:
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Year = 1995to report title
Year = 1994to column C
Year = 1994to column E
Year = 1994to column F

apop

4. To create a Study:
* This Study has been created for you. If you wish to create it yourself,
follow these steps. Otherwise, skip to step 5.

With the Store dimension selected, click B'rewseﬁ button.

In the Browser window, seleStudy Changesrom the Tools menu.
Select theStore Sqftfield to study.

For Type, choos¥alue Unchanged

Leave<Any Value> selected in the From box agdll Times>
selected for the time constraint for the study.

Click OK .

g. Namethe studyJnchanged Sqg. Ft.

h. Click OK.

i. Close the Browser window.

P20 T®

.

5. To use a Study:
* From the Store dimension, click tBéudiestab and drag and drop the study
namedJnchanged Sq. Ftto column E.
*  When prompted to choose a time period for the study, gdleittime and
click OK.

6. To create another Study:
* This Study has been created for you. If you wish to create it yourself,
follow these steps. Otherwise, skip to step 7.

With the Store dimension selected, click Brewseﬂ button.

In the Browser window, seleStudy Changedrom the Tools menu.
Select theStore Sqftfield to study.

For Type, choos¥alue Increase

In the box marked Min entér

SelectMonth = 01/31/19950r the time constraint for the study.
Click OK.

Namethe studyincreased Sq. Ft. in 1/95

Click OK.

Close the Browser window.

S@rpa0 o

— —

7. To use a Study:
* From the Store dimension, cli€tudiestab and drag and drop the study
namedncreased Sq. Ft. in 1/9%0 column F.
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When prompted to choose a time period for the study, gdledttime and
click OK.

8. To create a comparison:

Right click on column E (Unchanged Sq. Ft.) and select
Properties>Comparison.

SelectPercent Difference of

Click OK.

Right click on column F (Increased Sq. Ft.) and select
Properties>Comparison.

SelectPercent Difference of

Click OK.

While holding down th&hift key, drag and droplnchanged Sq. Ftfrom

the Studiestab on the Store dimension onto column E. Using the shift key
sets the date as the one being compared.

When prompted to choose a time period for the study, gdledttime and
click OK.

While holding down th&hift key, drag and dropcreased Sq. Ft. in 1/95
from theStudiestab on the Store dimension onto column F. Using the shift
key sets the date as the one being compared.

When prompted to choose a time period for the study, gdledttime and
click OK.

9. To create an average:

Right click on column E (Unchanged Sg. Ft.) and select
Properties>Aggregate

SelectAverage

Click OK.

Right click on column F (Increased Sq. Ft.) and select
Properties>Aggregate

SelectAverage

Click OK.

10. To constrain report and create report title:

From the Product dimension, click tBeoups tab and drag and drop
Brand = Western Vegetableonto the report title area.

11. To change a column heading:

Right click on column E and seleletoperties>Heading.

Place the cursor in tf@olumn Heading edit box at the end of the line
Dollar Salesand pres&nter.

Typefor unremodeled stores

Click OK.
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* Right click on column F and seleetoperties>Heading.

* Place the cursor in th@olumn Heading edit box at the end of the line
Dollar Salesand pres&nter.

* Typefor remodeled stores

* Click OK.

12. To create a sort:

* Right click on column F and seldetoperties> Sort.
* Select from Column for primary sort.

* SelectDescendingrom Direction for primary sort.

* Click OK.

13.To run report:
* Click Run Report _I

14. To switch to report view:
* ChooseView->Report from the menu.

if. Synchrony - [Single View]

File Edit “iew Report Tool: Help

oleel @ BElE]| o=z 2 2] |
T

Selks i~ Dimengions [Time: Y'ear = 1935]
&Eustomer Count Timne Fieldz | Groups I Studiesl
Product
é} Dollar Cost Pramation @ Date -
& Dallar Sales Store % Day Mumber In Month
&= Product Key @ D ay Mumber Overall
E= Promation Key <$ Day Of Week
&= Stare Rey =l % Fiscal Period
& Holiday Flag [
| Slewly Changing Dimension
| for ‘rear = 19595, Brand = Westem Vegetable
P B C [ D [ E [ F =
Percent Percent
Difference of Difference of J
Avg of Avg of
1 Dollar Sales Dollar Sales
Sum of for unremodeled stores  for remodeled stores
Dollar Sales Sum of for Year = 1995 for Year = 1995
Mame Sales Region |for Year = 1994 Dollar Sales vz Year = 1994 ws Year = 1994
8 |StoreMao 20 Midwest $7.520.28 $10.378.16 B.43%
9 |StoreMa 4 Pacific $3.730.81 $3.274.40 A1.27%
10 | StoreMa 5 Pacific $8.988.59 $10.520.14 B.75%
11 | StoreMa 7 Eastemn $8.937.594 $5.548.94 B 2R
12 |StoreMo 8 Southwest $8.647.595 $3.936.07 2200
13 | Store Mo 17 Mid Atantic $3.434.01 $11.569.83 21.99%
14 |StoreMo B Eastemn $10.238.16 $11.402.77 20.40%
15 | Store Moo 2 Midwest $8.086.64 $3.822.59 18.21%
16 |Store Mo 9 Pacific $10.465.50 $3.646.54 13.48% &
1] | LIJ
[ Family: | Grocery | a5 | 1204PM 4
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This is an example of a complex query whe8tualy is created anslowly

changing dimensionsare demonstrated by identifying tlgangebetween two

periods. Synchrony is the only analytic software today that combines the power of
Studiesandtemporal technologyto trackslowly changing dimensions.

Grace is in the Brand Management Department of a major grocery store chain.
She wants to increase the sales of the Big Can brand and Cold Gourmet brand
foods. She wants to determine if promotions of the Big Can brand increases the
sales of the Cold Gourmet brand foods. She wants to identify the stores that had
promotions of the Big Can brand and carried the Cold Gourmet brand. She wants
to determine total sales of Cold Gourmet in 1994 and total sales of Cold Gourmet
in 1995, and the percentage difference between total unit sales of Cold Gourmet in
1994 and total unit sales of Cold Gourmet in 1995

This is a complex query whereésgudy is created to save thesults of a constraint
of grocery stores that carried the Big Can brand and the Cold GourmetTirand.
results of applying constraints on various dimensions in a report can be saved
as a Study Few query tools are able to saverbsults of constraintas in
SynchronyA comparisonis done on the Study to compare the sales of Cold
Gourmet in 1994 and 1995.

To create a new report:

Go toFile->New on the menu.

Click onGrocery.

Click OK.

If a dialogue box comes up asking if you want to save the reportNdick
ChooseView->Singleon the menu.

1. To create Studies:
* These Studies were created for you. If you wish to create them yourself,

follow these steps. Otherwise, skip to step 2.

a. From the Store dimension, drag and debpre Key.

b. From Sales (Fact table), drag and doaiar Sales

c. From the Product dimension, click @eoups tab and drag and drop
Brand = Big Can onto the report title area.

d. From the Promotion dimension, click t@eoups tab then drag and
dropAll Promos onto the report title area.

e. Right click on column B (Dollar Sales) and select

Properties>Exceptions
f. For Report Display, sele€@mit Nulls by checking the box.
g. Click OK.

h. Click Run Report.
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Right click on column A (Store Key) and selé€ireate Study:
Namethe studyStores with Big Can Promo

Click OK.

From Product dimension, select tAmups tab and drag and drop
Brand = Cold Gourmet to the report title.

Right click on the report title. A dialog box will appear.

In the dialog box, select tliromotion dimension then click thReset
button — the Promotions constraint is removed from the report.
Click Close

Click Run Report.

Right click on column A (Store Key) and selé€ireate Study:
Namethe studyStores Carrying Cold Gourmet

Click OK.

To clear the report used in creating the Study, chietese New from
the menu and select tliocery family and clickOK. When asked if
you want to save the report, respdial

2. To create a Study by combining two Studies:

SQ@rpapop

I.
j-

With the Store dimension selected, click B'rewseﬁ button.
SelectCombine from the Tools menu of the Browser.

Select théStudiesoption button.

For Constraint A choossgtores with Big Can Promo

For the Operator choosatersection/AND.

For Constraint B choosgtores Carrying Cold Gourmet

Click Save

Namethe combined studgtores with Big Can Promo Carrying
Cold Gourmet.

Click OK.

Close the Browser window.

3. To create report title:
* Right click on the report title area.
* Click in the Report Title edit box and ty@rocery — Study and
Comparison.
* Click Close

4. To select fields for your report:
* From the Store dimension, drag and dx@meto column A.
* From Sales (Fact Table), drag and dbgflar Salesto column B.
* From Sales, drag and drbjmit Salesto column C.

5. To use a Study:
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From the Store dimension, click tBéudiestab and drag and drop the study
Stores with Big Can Promo Carrying Cold Gourmetto the report title.

6. To select dates to constrain fields:

From the Time dimension, click tii&oups tab and drag and drop the
following:

a. Year =1994to column B

b. Year =1994to column C

7. To select brands to constrain fields

From the Product dimension, click the Groups tab and drag and drop the
following:

a. Brand = Cold Gourmetto column B

b. Brand = Cold Gourmetto column C

8. To create a comparison:

Right click on column B (Dollar Sales) and select

Properties>Comparison.

SelectPercent Difference of

Click OK.

Right click on column C (Unit Sales) and selBabperties>Comparison
SelectPercent Difference of

Click OK.

While holding down th&hift key, drag and drojyear = 1995from the

Groups tab on the Time dimension onto column B. Using the shift key sets
the date as the one being compared.

While holding down th&hift key, drag and drojyear = 1995from the

Groups tab on the Time dimension onto column C. Using the shift key sets
the date as the one being compared.

While holding down th&hift key, drag and droBrand = Cold Gourmet

from theGroups tab on the Product dimension onto column B. Using the
shift key sets the brand as the one being compared.

While holding down thé&hift key, drag and droBrand = Cold Gourmet

from theGroups tab on the Product dimension onto column C. Using the
shift key sets the brand as the one being compared.

9. To create a sort:

Right click on column B and seleBtoperties> Sort.
SelectB from Column for the primary sort.
SelectDescendingrrom Direction for the primary sort.
Click OK.

10. To run report:
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* Click Run Report _I

11. To select report view:
* ChooseView->Report from the menu.

if. Synchiony - [Single View]
File Edit “iew Heport Tools

Help

D=2 & BEl=] o|n]s] 5 2
[ =

- — Dimenzions [Time: Al Times]
& Customer Count Time Fields | Groups I Studiesl
& ot o fohe | [ow :
& Dallar Sales Stare 3 Day Mumber In Month
&= Product Key o & Day Mumber Overal
&= Pramiotion Key @ Diay OFweek
£ Stare Key =l % Fiscal Period
& Holiday Flag =l
| Grocery-Study and Comparison
| for &ll Stores in Stores with Big Can Promo Carrving Cold Gourmet
& e [ ¢ [ o | e [ F [T & [ H [ =
Percent [
Difference of Percent
Sum of Difference of
1 Dollar Sales Sum of
for Year = 199%  Unit Sales
vs. Year = 1994 for Year = 1995
Mame Sorted Down vs. Year = 1994
2 |Store Moo 15 4972% 44 48%
3 |Store Moo 13 40.08% 42 4B%
4 |Store Mo 2 3E.82% 39.08%
5 |Stoe Mool 3201% 32.00%
E_|Store Moo 10 2327E 21.08%
7 |Store Mo 17 1851% 1E.92%
8 |Stoe Mo 12 15.70% 17.38%
3 |StoeMo 8 1319% 17.89%
10 | StoreMo. 9 10.36% 14.89% -
1] | LIJ
[ Family: | Groceny | &mmE | 1207PM g

This is a complex query withStudy and acomparisonmade within the Study.
Few query tools are able to saversults of constraintas in Synchrony.

Synchrony saves thiesults of constraintthat can then be used as the basis of other

reports.

Grace is in the Brand Management Department of a major grocery store chain.
She wants to increase the sales of the Big Can brand and Cold Gourmet brand
foods. Based on the previous question where she identified the stores that had
promotions of the Big Can Brand and carried the Cold Gourmet brand foods,
Grace now wants to compare by store the sales of Cold Gourmet in 1994 to the

sales of Cold Gourmet in 1995 and calculate the percentage difference between the
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two years. She wants to compare by store the number of unit sales of Cold
Gourmet in 1994 to unit sales of Cold Gourmet in 1995 and calculate a percentage
difference between the two years

This is a very complex query wher&tudy is reused. The previous Study which
has thaesults of a constrairis used as the basis of this new report.

To create a new report:
* Go toFile=>New on the menu.
* Click onGrocery.
* Click OK.
* If a dialogue box comes up asking if you want to save theNtick
* ChooseView->Singleon the menu.
1. To create a Study:
* This report uses the same Study caieates with Big Can Promo
Carrying Cold Gourmet as created in the previous report. If you wish to
create the Study, see step 1 in the previous report for directions.

2. To create report title:
* Right click on the report title area.
* Click in the Report Title edit box and tySéudy with comparison
* Click Close

3. To select fields for your report:
* From the Store dimension, drag and dxgme onto column A.
* From Sales (Fact Table), drag and dbamfiar Salesonto column B.
* From Sales, drag and drbjmit Salesonto column C.
* From Sales, drag and drbpllar Salesonto column D.
* From Sales, drag and drbjmit Salesonto column E.
4. To use a Study:
* From theStudiestab on the Store dimension, drag and drop the study
Stores with Big Can Promo Carrying Cold Gourmetto the report title.

5. To select dates to constrain fields:
* From the Time dimension, clicBroups tab and drag and drop the
following:
a. Year =1994to column B
b. Year =1994to column C
c. Year =1994to column D
d. Year =1994to column E

6. To select brands to constrain fields
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* From the Product dimension, click the Groups tab and drag and drop the
following:
c. Brand = Cold Gourmetto column B
d. Brand = Cold Gourmetto column C
e. Brand = Big Canto column D
f. Brand = Big Canto column E

7. To create comparisons:
* Right click on column B (Dollar Sales) and select

Properties>Comparison.

SelectPercent Difference of

Click OK.

Right click on column C (Unit Sales) and selBabperties>Comparison.

SelectPercent Difference of

Click OK.

Right click on column D (Dollar Sales) and select

Properties>Comparison.

SelectPercent Difference of

Click OK.

Right click on column E (Unit Sales) and selRobperties>Comparison.

SelectPercent Difference of

Click OK.

While holding down th&hift key, drag and drogear = 1995from the

Groups tab on the Time dimension onto column B. Using the shift key sets

the date as the one being compared.

* While holding down th&hift key, drag and drogear = 1995from the
Groups tab on the Time dimension onto column C. Using the shift key sets
the date as the one being compared.

* While holding down th&hift key, drag and drogear = 1995from the
Groups tab on the Time dimension onto column D. Using the shift key sets
the date as the one being compared.

* While holding down th&hift key, drag and drogear = 1995from the
Groups tab on the Time dimension onto column E. Using the shift key sets
the date as the one being compared.

*  While holding down th&hift key, drag and droBrand = Cold Gourmet
from theGroups tab on the Product dimension onto column B. Using the
shift key sets the brand as the one being compared.

* While holding down th&hift key, drag and droBrand = Cold Gourmet
from theGroups tab on the Product dimension onto column C. Using the
shift key sets the brand as the one being compared.

* While holding down th&hift key, drag and droBrand = Big Can from
theGroups tab on the Product dimension onto column D. Using the shift
key sets the brand as the one being compared.
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* While holding down th&hift key, drag and droBrand = Big Can from
the Groups tab on the Product dimension onto column E. Using the shift
key sets the brand as the one being compared.

8. To create a sort:
* Right click on column B and seleBtoperties> Sort.
* SelectB from Column for the primary sort.
* SelectDescendingrom Direction for the primary sort.
* Click OK.
9. To change column headings:
* Right click on column B and seleBtroperties>Heading.
* Place the cursor in ti@olumn Heading edit box at the end of the line
Dollar Salesand pres&nter.
Typefor Cold Gourmet.
Click OK.
Right click on column C and seleetoperties>Heading.
Place the cursor in tf@olumn Heading edit box at the end of the litnit
Salesand pres&nter.
Typefor Cold Gourmet.
Click OK.
Right click on column D and seleBtroperties>Heading.
Place the cursor in tf@olumn Headingedit box at the end of the line
Dollar Salesand pres&nter.
Typefor Big Can.
Click OK.
Right click on column E and seletoperties>Heading.
Place the cursor in tf@olumn Heading edit box at the end of the litunit
Salesand pres&nter.
Typefor Big Can.
* Click OK.

10. To run report:
* Click Run Report _I

11. To view full report:
* ChooseView->Report from the menu.
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if. Synchiony - [Single View]
File Edit “iew Heport Toolz Help
Cl=g @ BEE] e ls] o 9 |
- | 2| Dimenzions [Time: Al Times]
& Customer Count Time Fields | Groups I Studiesl
Product
é} Drollar Cost Pramotion @ Date -
& Dallar Sales Stare 3 Day Mumber In Month
&= Product Key & Day Mumber Overal
&= Pramiotion Key @ Diay OFweek
£ Stare Key =l % Fiscal Period
& Holiday Flag =l
| Study with companzon
| for &ll Stores in Stores with Big Can Promo Carrving Cold Gourmet
b B | C | D | E [ F [ & =
Percent |
Difference of Percent Percent Percent
Sum of Difference of Difference of Difference of
1 Dollar Sales Sum of Sum of Sum of
for Cold Gournet  Unit Sales Dollar Sales Unit 5ales
forYear =1995% For Cold Gourmet Ffor Big Can for Big Can
vs Year = 1994 for Year = 1995 for Year = 1995 for Year = 1995
Name Sorted Down vs. Year = 1994 ws Year = 1994 vs. Year = 1994
2 |StareMa 15 49.72% 44.48% 9.658% 18.72%
3 |StareMa 13 40.08% 42 4B% A% 11.83%
4 |StareMa 2 3582k 39.08% 15.09% 324%
5 |StareMa 1 3201% 32.00% 5.93% 11.92%
E_|StareMa 10 2327H 21.05% -4 32% 3.48%
7 |StareMa 17 1851k 16.92% 753 14.87%
8 |StareMa 12 15.70% 17.35% 13 66X 15.27%
9 |StoreMa B 1319% 17.89% 16.43% 4.04% -
PR g S e PR LIJ
[ Family: | Groceny | msmmE | 1Z1PM g

This is a very complex query wher&tudy is reused. The previous report created
a Study which saved thesults of constraintand is used as the basis of this new
report.
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Frequent Flyer Data Mart

Andy is in the Pricing Department of a large airline. He wants to understand the
growth in fares by fare class for the month of November 1995 compared to
November 1994

This is a simple query that compares two snapshots of data in time. Most query
tools can run simple queries such as this one.

To create a new report

Go toFile=>»New on the menu.

Click onFrequent Flyer.

Click OK.

If a dialogue box comes up asking if you want to save the reportNaick
ChooseView->Singleon the menu.

1. To select fields for your report:

From the Fare Class dimension, drag and Beyp Class Description
onto column A.

From Frequent Flyer (Fact Table), drag and dhae threetimes onto
columns B, C and D.

From the Date Flown dimension, cli@oups tab and drag and drop the
following:

a. Flown Month = 11/1994to column B

b. Flown Month =11/1995to column C

c. Flown Month = 11/1994to column D

2. To create report title:

Right click on the report title area.

Click in the Report Title edit box and typeequent Flyer — Nov 94 vs.
Nov 95

Click Close

3. To create a comparison:

Right click on column D (Fare 11/1994) and select
Properties>Comparison.
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* SelectDifference of

* Click OK.

* While holding down th&hift key, drag and droplown Month = 11/1995
from theGroups tab on the Date Flown dimension onto column D. Using
the shift key sets the date as the one being compared.

4. To run report:
* Click Run Report _I

5. To select report view:

* ChooseView->Report from the menu.

if.. Synchrony - [Single View]
File Edit “iew Beport Toolz Help
D|==| @ == =] l/|l|-| st 2| |
Frequent Flyer — Dimensionz [D ate Flown: All D ate Flowns]
&= Channel Key Date Flown |« Fields | Groups | Studiesl
— || Customner
=
Customer Key Date Purchasze @ Flovn Date -
6’9 Fare Fare Class @ Flovan Day Mumber In Month
£ Fare Class Key E:EEE Slatus & Flavin Day Mumber Overal
=
ol E!|g.hl Ke_'r' . LI Leg Destinatior @ Flowwn Day Of wWeek
Leg Origin @ Flovan Fizcal Period ﬂ
Sales Channel J
| Frequent Flyer - Moy 94 ws MNow 95
| Mo Constraints
A B I C [ D [ e [ ¢ | & | =
Difference of =
Sum of
Fare
1 Sum of Sum of for Flown Month
Fare Fare =11/1995
Fare Clazz |(for Flown Month  for Flown Month vz Flown Month
Deszcription (= 11/1994 =11/19595 =11/1994
2 | Business $62,631.00 $57.329.00 $4,658.00
3 | Digcount $52,587.00 $65,590.00 $13,003.00
4 | Economy $61,650.00 $60.485.00 -$1.165.00
5| First $59.013.00 $56.594.00 $2.415.00
B
7
g
| -
1] | »
| Family: | Frequent Flyer | mrase | 1a2PM 4

This is a simple query that compares two snapshots of data in time. Most query
tools can run simple queries such as this one.
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Jason is in the Finance Department of a large airline. He is looking for ways to
decrease the cost of his sales channels. He has just been told that his airline is
considering reducing the commission paid to the travel agent sales channel. He
wants to determine the average ticket fares in each ticket fare class in 1995 and
compare the average ticket fares in the travel agent sales channel to the direct
counter sales channel

This is an example of a complex query whetersstraint is created to identify

ticket fares in the travel agent sales channel and in the direct counter sales channel.
A comparisonis made between the two constraints. Some query tools are able to
run this complex query.

To create a new report:
* Go toFile=>New on the menu.
* Click onFrequent Flyer.
* Click OK.
* |f a dialogue box comes up asking if you want to save the reportNaick
* ChooseView->»Singleon the menu.

1. To select fields for your report:

* From the Fare Class dimension, drag and Beop Class Description
onto column A.

* From Frequent Flyer (Fact Table), drag and diae threetimes onto
columns B, C and D.

* From theGroupstab on the Sales Channel dimension, drag and drop the
following:
a. Channel Name = Travel Agento column B
b. Channel Name = Direct Counterto column C
c. Channel Name = Direct Counterto column D

2. To create report title:
* Right click on the report title area.
* Click in the Report Title edit box and typeequent Flyer — Agent vs.
Counter Sales
* Click Close

3. To create a comparison:
* Right click on column D (Fare Direct Counter ) and select

Properties>Comparison.
¢ SelectPercent Difference of
¢ Click OK.

* While holding down th&hift key, drag and droghannel Name = Travel
Agent from theGroups tab on the Sales Channel dimension onto column
D. Using the shift key sets the channel as the one being compared.

43



FREQUENT FLYER DATA MART

* From the Groups tab on the Date Flown dimension, drag andrldrnop
Year = 19950nto the report title.

4. To run report:
* Click Run Report _I

5. To View Report:
* ChooseView->Report from the menu.

if. Synchrony - [Single View]
File Edit “iew Heport Toolz Help

B E EEE R ] |
T =

Frequent Flyer — Dimensions [0 ate Flawn: Flown Year = 1935]
& Channel Key Date Flowrn |« Fields I Groups | Studiesl
= || Customner
[
Customer Key Date Purchase @ Flovn Date =
& Fare Fare Class @ Flavwn D ay Murmber In Manth
& FCT'“E Class Key F::gm Shatus @ Flowr D ay Mumber Owveral
% Ehghl Ee‘l'l . LI Le% Destinatior: @ Flowin Day Ofweek
Leg Origin @ Flowar Fizzal Penod j
Sales Channel LI =
| Freguent Flyer - Aigents vs. Counter Sales
| for Flawn ‘rear = 1395
A E [ C [ D Il e | F | & | H =
Percent =
Difference of
Sum of
Fare
1 for Channel
Sum of Sum of Mame = Travel
Fare Fare Agent
for Channel for Channel vz Channel
Fare Class |[Name = Travel MName = Direct Mame = Direct
Description |Agent Counter Counter
2 | Business $54.101.00 $52.083.00 39%
3| Digcount $54.159.00 $50,106.00 8.09%
4 | Econaomy $37.594.00 $45,751.00 A7.83%
5 | First $37B12.00 $48.183.00 -21.95%
E
= h
1] | |
| Family: | Frequent Flyer | ears | 1aPM

This is an example of a complex query whetersstraint is created and a
comparisonis made. Some query tools are able to run this complex query.




FREQUENT FLYER DATA MART

Claudia is in the Marketing Department of a large airline. She is looking to
increase revenue by offering new products to a profitable segment of customers. In
identifying a profitable segment of customers, she wants to understand how
stowtry increases in household income affect increases in miles flown on her airline. She
CHANGING wants to identify customers that had an increase in household income of between
DIMENSIONS 1% and 15% and those with an increase greater than 15%. She then wants to

COMPLEX

QUERY AND

compare the number of miles each group flew in 1994 compared to the number of
miles each group flew in 1995 and find the percentage difference in miles flown
between the two years for each group. She wants to sort the results in descending
order by the difference in miles between 1994 and 1995 for all customers

This is a very complex query where t&tudiesare created; one that saves the
results of constraintfor the customers with a 1-15% increase in household income,
and a second Study that saves#sellts oiconstraintsfor the customers with a
greater than 15% increase in household incdime results of applying

constraints on various dimensions in a report can be saved as a Stuéfgw

guery tools are able to save thsults of constraintas in Synchrony.

Slowly changing dimensiongontain data that tend to change gradually over

time. Customer and product information are the most common data that varies
over time. If the speed of your industry is outpacing your data, then chances are
you have data that varies over time and you need analytic software that can track
slowly changing dimensiondn this exampleslowly changing dimensionsre
demonstrated by identifying tlthangein miles flown between 1994 and 1995 for
each group of customers that had an increase in household income. Synchrony is
the only analytic software today that combines the powstuafiesandtemporal
technologyto trackslowly changing dimensions.

To create a new report
* Go toFile=>New on the menu.
Click onFrequent Flyer.
Click OK.
If a dialogue box comes up asking if you want to save the reporiNdick
ChooseView->Singleon the menu.

1. To select the fields for your report:

* From the Customer dimension, drag and @aptomer Nameonto
column A.

* From Frequent Flyer (Fact Table), drag and diides five times onto
columns B, C, D, Eand F.

* From theGroups tab on the Date Flown dimension, drag and drop the
following:
a. Flown Year = 1994to column B
b. Flown Year = 1995to column C
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Flown Year = 1994to column D
Flown Year = 1994to column E
Flown Year = 1994to column F
Flown Year = 1995to report title

~® Qo0

2. To create report title:
* Right click on the report title area.
* Click in the Report Title edit box and typeequent Flyer with SCD.
* Click Close

3. To create a Study:
* This Study has been created for you. If you wish to create it yourself,
follow these steps. Otherwise, skip to step 4.
a. With the Customer dimension selected, cIicthewseﬂ
button.
b. Inthe Browser window, seleStudy Changedrom the Tools
menu.
Select theCustomer Incomefield to study.
For Type, choosBercent Increase
In the box labeletlin, enter0.01
In the box labeletlax, enter0.15
Leave<All Times> selected for the time constraint for the study.
Click OK.
Namethe studyincome Increase 1-15%
Click OK.
Close the Browser window.

S@ ™o ao

4. To use a Study:
* From the Customer dimension, click ®idiestab and drag and drop the
study namedhcome Increase 1-15%0o column E.
*  When prompted to choose a time period for the Study, gdlexfttime
and clickOK.

5. To create a Study:
* This Study has been created for you. If you wish to create it yourself,
follow these steps. Otherwise, skip to step 6.

a. With the Customer dimension selected, cIicthewseﬂ button.
b. In the Browser window, seleStudy Changedrom the Tools menu.
c. Select theCustomer Incomefield to study.

d. For Type, choosPercent Increase

e. Inthe box marked Min entéx15

f. Leave {All Times> selected for the time constraint for the study.
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g. Click OK.

h. Namethe studyncome Increase > 15%
i. Click OK.

j. Close the Browser window.

6. To use a Study:

From the Customer dimension, cliSkudiestab and drag and drop the
study namedhcome Increase > 15%o column F.

When prompted to choose a time period for the Study, gdlefttime
and clickOK.

7. To create a comparison:

Right click on column D (Miles 1994) and select
Properties>Comparison.

SelectPercent Difference of

Click OK.

Right click on column E (Income Increase 1-15% 1994) and select
Properties>Comparison.

SelectPercent Difference of

Click OK.

Right click on column F (Income Increase > 15% 1994) and select
Properties>Comparison.

SelectPercent Difference of

Click OK.

While holding down th&hift key, drag and dropncome Increase 1-15%
from the Studies tab on the Customer dimension onto column E (Percent
Difference with Income Increase 1-15%). Using the shift key sets the date
as the one being compared.

When prompted to choose a time period for the Study, gdlefttime

and clickOK.

While holding down th&hift key, drag and dropncome Increase > 15%
from the Studies tab on the Customer dimension onto column F (Percent
Difference with Income Increase > 15%). Using the shift key sets the date
as the one being compared.

When prompted to choose a time period for the Study, gdlefttime

and clickOK.

8. To create a sort:

Right click on column D (Percent Difference) and sel¥operties>Sort.
SelectD from theColumn drop down list box for the primary sort.
SelectDescendingrrom theDirection drop down list box for the primary
sort.

Click OK.
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9. To change column headings:

Right click on column B and seletoperties>Heading.

Select all the text in th€olumn Headingedit box and press tlizelete
key.

Enter a new heading d¥liles Flown <Enter> in 1994 pressing the Enter
key where you see <Enter>.

Click OK.

Right click on column C and seldetoperties>Heading.

Select all the text in th€olumn Headingedit box and press tlizelete
key.

Enter a new heading d¥liles Flown <Enter> in 1995 pressing the Enter
key where you see <Enter>.

Click OK.

Right click on column D and seleBtroperties>Heading.

Select all the text in th€olumn Headingedit box and press tlizelete
key.

Enter a new heading d€hange in Miles Flown <Enter> for All
Customers <Enter> From 1994 to 1995 <Enter> Sorted Dowpressing
the Enter key where you see <Enter>.

Click OK.

Right click on column E and seleetoperties>Heading.

Select all the text in théolumn Headingedit box and press tlizelete
key.

Enter a new heading d€hange in Miles Flown <Enter> for Customers
with <Enter> Income Increase of 1-15% <Enter> From 1994 to 1995
pressing the Enter key where you see <Enter>.

Click OK.

Right click on column F and seldeétoperties>Heading.

Select all the text in th€olumn Headingedit box and press tlizelete
key.

Enter a new heading d€hange in Miles Flown <Enter> for Customers
with <Enter> Income Increase of > 15% <Enter> From 1994 to 1995
pressing the Enter key where you see <Enter>.

Click OK.

10. To remove blank rows:

Right click on column D and seleBroperties>Exceptions
Check theDmit Nulls box.
Click OK.

11.To run report:

Click Run Report _I
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12.To view full report:
* ChooseView->Report from the menu.

if. Synchrony - [Single View]
File Edit “iew Heport Toolz Help

B E EEE R ] |
T =

— Dimensions [0 ate Flawn: Flown Year = 1935]
Fields I Groups | Studiesl

@ Flowsr D ke -

Frequent Flyer
&= Channel Key
&= Cuistomer Key

Date Flown |
= || Customner

D ate Purchase
& Fare F‘_are Class @ Flowar D ay Mumber In Manth
= FcTIrE Class Key F:'QEE Siat @ Flowsn Day Number Dveral
% Ellghl EE_',' . LI Lé% Des?i:jtior @ Flavan Day Of wWeek
o Leg Origin @ Flowar Fizzal Penod j

Sales Channel LI =

| Freguent Flyer with SCD
| for Flawn ‘rear = 1395

A B | c | D | E | F JIE
Change in Miles Flown Change in Miles Flown Change in Miles Flown [
1 Hiles Milez Ffor All Customers for Customers with for Customers with
Customer |[Flown Flown From 1994 to 1995 Income Increase of 1-15% | Income Increase of >15%
Name in 1994 in 1995 Sorted Down From 1994 o 1995 From 1994 1o 1995
2 | Ottiz 25,108 58562 133.24% 133.24%
3 |Wargas 23,835  R0431 111.58% 111.58%
4 | Emamy 28428 4B.000 A0.92% 80.92%
b |Hale 25,804 45224 TRZEE 7h.26%
E | Clewett 27349 46919 71.56% 71.56%
7 |Werch 28230 48363 71.32% 71.32%
8 | Galt 28,883 47078 F3.00% £3.00%
9 | Guiroz 24524 39743 G2.06% 62.06%
10| Richards 30627 48388 57.99% 57.99%
11 Guy .383 484939 55.94% 556.94%
bl [T 24 7070 e =Ryely] E2 ACE B2 ACE i
«i | 5]
| Family: | Frequent Flyer | esars | tzapM

This is an example of a very complex query whereStudliesare created and
slowly changinglimensionsre tracked for each Study. Obtaining the answer to
this very complex question is extremely difficult. Only Synchrony with its ability to
createStudiesand applyemporal technologycan perform this query easily.

Matthew is in the Marketing Department of a large airline. He wants to send direct
mail advertising to a targeted group of customers that fly out of JFK Airport in New
York. He wants to identify the customers that flew from JFK Airport in November
1994 and had over 500 miles in their account. He wants to produce the mailing list
that includes customer name, address, city, state, zip code, and number of miles
flown.

This is a complex query wheré&Séudy is created that saves ttesults of
constraintshat represents the set of customers that flew out of JFK Airport in

49



FREQUENT FLYER DATA MART

November 1994 and had over 500 miles in their acc®tetresults of applying
constraints on various dimensions in a report can be saved as a Stubgw
guery tools are able to save thsults of constraintas in Synchrony. This complex
guery also demonstrates tadmic datatransaction level data) can be obtained
and individual customer account information can be put onto a report for a
Marketing direct mailing.

To create a new report:

1.

2.

3.

Go toFile=>»New on the menu.

Click onFrequent Flyer.

Click OK.

If a dialogue box comes up asking if you want to save the reporiNdick
ChooseView->Singleon the menu.

To create a Study:

This Study was created for you. If you wish to create it yourself, follow

these steps. Otherwise, skip to step 2.

a. From the Customer dimension, drag and d®aptomer Key.

b. From theGroups tab on the Date Flown dimension, drag and drop
Flown Month = 11/1994onto the report title.

c. From theGroups tab on the Trip Origin dimension, drag and dfoip

Origin Name = JFK onto the report title area.

Click Run Report.

Right click on column A (Customer Key) and sel€ceate Study:

Namethe studyFlew in 11/94 from JFK

Click OK.

Open a new report in thieequent Flyer family.

Click No when asked if you want to save the report.

SQ@ oo

To create report title:

Right click on the report title area.
Click in the Report Title edit box and typeequent Flyer Study.
Click Close

To select fields for your report:

From the Customer dimension, drag and @@aptomer Nameonto
column A.

From the Customer dimension, drag and d@aptomer Addressonto
column B.

From the Customer dimension, drag and @@aptomer City onto column
C.

From the Customer dimension, drag and @@aptomer Stateonto column
D.
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* From the Customer dimension, drag and @aptomer Zip onto column
E.
* From Frequent Flyer (Fact Table), drag and dAdes onto column F.

4. To create an exception:
* Right click on column F (Miles) and seld@toperties>Exceptions
* For Top Condition, clickAt or Above Value of M
e Enter500in theM = edit box.
* For Report Display, seleBtestrict to Exceptions
* Click OK.
5. To use a Study:
* From theStudiestab on the Customer dimension, drag and drop the study
Flew in 11/94 from JFK onto the report title area.

6. Torun report:
* Click Run Report _I

7. To view full report:
* ChooseView->Report from the menu.
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ff. Synchrony - [Single Yiew]

Fle Edit “iew Bepot Toolz Help

N EEE R |
|

T «| 1 Dimensions [Date Flown: &ll D ate Flowns]

& Chanrel Key Date Flown | Fields I Groups | Studies'

& Customer Key b gl;iteolgnl.irchasec % Flown Dats -
& Fae Fare Class &% Flawn D ap Mumber In Month
&= Fare Class Key E:!QEt 5 &% Flown Day Mumber Dveral
E= Flight Key L;% Ig)ets?itr:‘.:tion & Flown D ap OF wieek
= Flight Status Key LI Leg Origin @ Flowan Fiscal Period

Sales Chanel | &, Fiown Holiday Flsa | |

| Frequent Flyer Study
| far &Il Cugtomers in Flew in 11,94 fram JFK

A B | c_ | D [k F |l 6 [ H ] =
1 |Customer Customer Customer Customer Customer |Sum of
Hame Address City State Zip Miles —
2 | Appley 1923 Shadp Lane  dnchorage Alazka TER4E| B4 572
3| Ashhy 9369 Shady Lane Juneau Alazka 74154  E7BSY
4 | Bamett 5332 Shady Lane | Phoenix Alizona BE392| AV
5 | Clewett 3997 Shady Lane  Fed Bluff Califarnia IFATY| 27548
E_ | Cluster 8640 Shady Lane | Denver Colorada E1392 71E14
7 _|Deadorf 8151 Shady Lane | Wilmington Delaware 40860  FE0E3
8 | Enckson 2254 Shady Lane Augusta Georgia E0397| 77738
9 | Ford 119 Shady Lane | Sun Yalley |daha T1E93| EERO3
10 _|Hale 584 Shady Lane  Council Bluffs  lowa AFR3E| 25804
11| Jackson 8614 Shady Lane  Bethesda Margland 11802 73158
12 _|lJenzen 8195 Shady Lane | Augusta taine 580358 27925
13 | Kitch 361 Shady Lane  Greenfield Mazzachusetts TRO2E| 24782 -
1] | LlJ
[ Family: | Frequent Flyer [ 10723098 | 1tmaM

This is a complex query where&séudy is created andtomic datareported in the
form of customer names and address. Few query tools are able t&trdae
that saves theesults of constraintand reporatomic data

Matthew is in the Marketing Department of a large airline. He wants to send direct
mail advertising to a target group of customers. In the previous query, he identified
the customers that flew from JFK Airport in November 1994 and had over 500

miles in their account. Now he thinks that he wants to refine his target group and
identify from the original group the subset of customers that had household income
over $50,000 and are married. He wants to list the customer name, address, city,
state, zip code, marital status, income, number of miles flown in 1994 so that he can
do a direct mailing from this report

This is a very complex query wher&tudy on a Studyis created. The previous
Study which saved thresults of a constrairfor a target group of customers is used
as the basis of this new Study. The new Studigaet of the results of the
previous constraintSynchrony stands alone in its ability to crestiedies on

Studies
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To create a new report
* Go toFile=>New on the menu.
* Click onFrequent Flyer.
* Click OK.
* |f a dialogue box comes up asking if you want to save the reporiNdick
* ChooseView->»Singleon the menu.
1. To create a Study:
* This Study has been created for you. If you wish to create it yourself,
follow these steps. Otherwise, skip to step 2.
a. From the Customer dimension, drag and d®aptomer Key.
b. From theGroups tab on the Customer dimension, drag and drop
Married and Income > $50konto the report title area.
c. From theStudiestab on the Customer dimension, drag and &tew
in 11/94 from JFK onto the report title area.
Click Run Report.
Right click on column A (Customer Key) and sel€ceate Study:
Namethe studyFlew 11/94 from JFK, Married, High Income.
Click OK.
Open a new report in thieequent Flyer family.
Click No when asked if you want to save the report.

S@ oo

2. To create report title:
* Right click on the report title area.
* Click in the Report Title edit box and typeequent Flyer - Study on
Study.
* Click Close

3. To select fields for your report:

From the Customer dimension, drag and @@aptomer Name
From the Customer dimension, drag and d@aptomer Address
From the Customer dimension, drag and @aptomer City.
From the Customer dimension, drag and daptomer State
From the Customer dimension, drag and @@aptomer Zip.
From the Customer dimension, drag and daptomer Marital .
From the Customer dimension, drag and @@aptomer Income
From Frequent Flyer (Fact Table), drag and dides.

From Frequent Flyer, drag and diegre.

4. To use a Study:
* From theStudiestab on the Customer dimension, drag and drop the study
Flew 11/94 from JFK, Married, High Income onto the report title.

5. To constrain report:
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* From theGroups tab on the Date Flown dimension, drag and éiogp/n
Year = 1994to the report title.

6. Torun report:
* Click Run Report _I

7. To select report view:
* ChooseView->Report from the menu.

if-. Synchrony - [Single View] [_ O] x]
File Edt “iew Beport Tool: Help
DR @ BEEE e 5 2 ‘
Frequert Fluer | |  Dimenzsiong [Date Flown: Flown Year = 1334]
&= Charinel Key Drate Flown | Field: | Groups | Studiesl
Cuztomner
&= Customer Key = || |Date Purchased @ Flawn Date -
& Fare Fare Class @ Flawen Day Mumber In Month
&= Fare Clasz Keyp E::gm Status Flown Day Mumber Dverall
P
= Flfght Key Leg Destination @ Flown Day Df ek
Flight Status Key LI Leg Origin @ Flowr Fiscal Period
Sales Charnel j & Flown Holiday Flag LI
| Frequent Flyer - Study on Study
| for Flown vear = 1994, All Customers in Flew 11494 from JFE, Married, High lncome
A | B [ C [ D [ e [T F T & H [ 1 J=
1 |Customer Customer Customer Customer Customer Customer Customer |Sum of Sum of
Hame Address City State Zip M arital Income Hiles Fare —
2| Ashby 9369 Shady Lane  Juneau Alaska 74154 Maried $34,000[ 32838 3625200
3| Barrett 5332 Shadp Lane  Phoenix Arizana 88392 Maried $117.0000 32,378 $6.151.00
4 | Deardarff 8151 Shady Lane  'wilmington Delaware 40860 M arried $62.000 32653 $6.203.00
5 |Ford 119ShadpLane | Sunalley Idaha 71639 Married $76.000] 36,805 $6.934.00
B | Jackson 8614 Shady Lane | Bethesda taryland 11802 M arried $80.000) 32,050 $6.088.00
7 |Kitch 361 ShadyLane | Greenfield Maszachusetts 7E026 M aried $60,000] 24,782 $4.708.00
8 |Landino 700 ShadyLane Minneapolis Minnesota 23552 Married $62.000] 33,047 $6.277.00
9 | Moran 3147 Shadp Lane | Bozeman Mantana 4309 Maried $109.000( 39450 $7.495.00
10| Miglzon 9511 Shady Lane | Lincoln Nebraska 32541 Maried $100,000f 37706 $7.164.00
11| Pavlovich 5692 Shady Lane  Mew York New York 372 Maried $81.000f 31,709 $6,027.00
12 | Quick 4374 Shady Lane | Greensboro | Morth Caroling 37164 Married $33.000) 26723 $6.030.00
I13 Utzig a541 SIhacI}I Lane | Knosvile Tennessee 99749 Maried $94,000[ 32834 $7.389.00 -
[ »
[ Family: | Frequent Flyer | 10/23/98 | 1057aM 4

This is a very complex query wher&tudy on a Studyis created. Few query

tools are able to save thesults of constraintas in Synchrony and no other is able

to subset and then save the results optlegious constraintsThe new subset is

saved and can be used as the basis of a new query. Synchrony stands alone in its
ability to createStudies on Studies
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